
Notes on Release 5.0 

 

Terminal 

• QVT/Term now supports the Secure Shell protocol version 1. 

• When the DEC Fixed font is used, the selected font size (small, medium, large, or auto) is now 
saved correctly when a "Save Configuration" is performed. 

• Printing is now done in a separate thread. This reduces interference between the print job and the 
terminal session, while the print job is running. 

• The script language now includes two new statements: "connect <host>", and "disconnect". Since 
the addition of these statements implies that a script can be run without a pre-existing session, the 
"File | Execute Script" menu item is now enabled at all times, even if no network connection is 
present. 

• Two new "hot keys" have been added: <Alt+X>, to execute a script, and <Alt+P>, to toggle auto-
print mode. Note that due to the second of these, the shortcut key to access the "Printer" menu is 
now <Alt+R>. 

• A "Find" option has been added to the "Edit" menu. This option supports searching for text in the 
QVT/Term buffer. 

• The seria l port can now be configured to run at rates up to 115,200 bps. 

• The maximum logical line length has been extended from 160 characters to 240. This allows 
QVT/Term to operate correctly where very small fonts (e.g. Terminal 6pt) are used on large, 
high-res displays. 

• The cursor shape can now be selected, either block (the default) or underline. 

• A new menuitem – "Launch" – has been added to expedite the selection of configurations 
(normally done through the "File | Open" menuitem). Using this menu, you can select a 
configuration and immediately open a new session (possibly in a new window) using that 
configuration. This feature is similar in concept to the "MRU List" of hosts that is found on the 
"File" menu, except that it employs entire QVT/Term configurations, not just hosts. 

• The default "paste mode" – normal or slow – is now a user-selectable option. As delivered, the 
paste mode is "normal" (i.e., "fast"), but you can now select "slow" as the default paste mode. 
This option is available for both default settings and current settings. 

• By default, QVT/Term uses the right mouse button to expedite cut-and-paste. This is a handy 
feature, but it also means that an accidental tap on the right button may cause data to be "pasted" 
into the host session. Beginning with this release, the user can disable this feature. 

• A sample TERM.CFG file, plus a keymap file for use with Gnu EMACS, are now included with 
theQVT/Term distribution. 

 



FTP Client 

• Greater control is now offered over the contents of the "ftphosts" file. You can now choose to 
save hosts, usernames, and passwords, hosts and usernames only, or hosts only. 

• The use of passive mode is now saved on a per-host basis. 

• FTP will now store file-type/file-extension mappings as they are selected during use. If a file type 
is initially unrecognized, the assigned setting will be used for future transfers of files with that 
extension. 

• It is now possible to close QVT/FTP even while a session is active. In prior releases, the user was 
required to close the session first, before closing the application window. 

  

Mail Client 

• The display of MS Exchange messages will now show the presence of attachments by appending 
a small "document" icon to the subject line (as is done for Internet messages). 

• New, unread messages are now represented by a pale yellow icon (instead of red). This results in 
a more pleasant, readable display. 

• When sending a mail message, you can now use Windows Explorer to browse for files which are 
to be sent as attachments, and simply drop the filenames onto the SendMail window. 

• If any notes and/or replies have been attached to a message, those notes will now be displayed 
together with the message (following the message proper); it is no longer necessary to click the 
"Notes" or "Replies" button to see this material (except for messages received and displayed in 
HTML format). 

• The Up-Arrow and Down-Arrow keys are now available to navigate through the message list. 

• If an attachment arrives in the form of a ZIP file, you can now select an unzip destination other 
than the default. 

• News server authentication is now handled on a per-server basis; there is no longer a "global" 
NNTP username and password. Instead, if you are using a news server that requires 
authentication, you should enter the server name in this form (in the "Preferences | News Servers" 
setup dialog): 

<username>:<password>@<servername>:<serverport> 

  

  



Notes on Release 4.3e 

  

Terminal 

• A bug that caused 8-bit control characters (e.g. CSI) to be ignored has been fixed. 

• When a "Save Configuration" is performed, the font size will be correctly saved in TERM.CFG 
even when the default "window size action" is set to "Font". 

• A "Keep Alive" option has been added to the "Default Settings | Connectivity" dialog. This option 
allows you to enable TCP/IP "keepalives", which may help in situations where the telnet host is 
causing inactive sessions to time out. 

• A bug in the handling of serial-port "Hardware" flow control has been fixed 

• Support for the MS LineDraw font as a printer font has been improved. Characters which are 
unique to this font will print correctly (i.e. high-bit characters). 

  

FTP Client 

• A new menu option has been added that allows you to type in an "ftp://" URL. 

• The "bye" command has been added to the script language. This command will close the FTP 
session and terminate QVT/FTP. 

  

Mail Client 

• A bug has been fixed that sometimes caused messages to appear twice in the "Incoming" folder. 

• The "MS Exchange" server is now a "first-class" server, and can be used exactly as POP3 servers 
are used. Specifically: you can now download from an Exchange server, and you can run a 
background mail check against an Exchange server. 

• A new option "Unread Messages Only" has been added to the "View" menu. When selected, this 
option will restrict the contents of the message list to only messages that have not yet been read. 

• If messages arriving from MS Exchange are moved to a local QVT/Mail folder, those messages 
will be handled properly if you later try to reply to them, or forward them. By this we mean that 
the reply will be sent via MAPI, not SMTP. 

• When reading messages directly from a server (either POP3 or MAPI), you can now move 
messages to a local QVT/Mail folder without first having to open the message. 

• You can now move entire message groups, not just individual messages, via drag-and-drop. 



Notes on Release 4.3b 

  

Terminal 

• A bug has been fixed which would cause QVT/Term to crash when used with a font so small that 
the maximum screen dimensions were exceeded. The new release enforces the limits in situations 
where an overflow would occur in previous releases. 

• A new printing option – "Close Print Jobs Manually" – has been added. This is for use in 
situations where it is desirable for an open print job to be held open indefinitely, due to the fact 
that print data arrives at a very irregular pace. When this option is selected, a print job, once 
opened, will stay open until it is closed by the user, via the "Printer" menu. A print job may also 
be closed programmatically be embedding a <Ctrl+Y> character (0x19) in the data stream. 

• You can now specify – in "Default Settings | Files" – the name of a .WAV file that should be 
played when the BEL character is received from the host. 

• If the screen is erased as part of an 80/132 column mode switch, the data on the screen will be 
saved to the scrollback buffer. Note that when this escape sequence is processed, the screen is 
erased even if the mode switch is not performed (because the screen is already in that mode). 

• The <F4> key is now correctly mapped to the <PF4> function. 

• The following statements have been added to the script processor: 

printer on|off  turn printer-controller mode on and off 

autoprint on|off  turn auto-print mode on and off 

logging on|off  open and close a log file 

quit    end the script and terminate QVT/Term 

  

FTP Server 

• A bug in the handling of "passive" mode has been fixed. 

  

Mail Client 

• The user interface has been updated. Instead of listing all message stores within a single tree, a 
listbar is provided which can be used to select the category of message store. All stores which 
belong to the selected category will be displayed in the list. Category selection buttons are 
provided for mail folders, mail servers, and news servers. 

• The right-button context menu has been expanded. The "Delete Group/Delete Thread" option is 
now made available at the message level, as well as the group/thread level of the tree. 



• The interaction between the mail client and the mail background checker has been improved. If 
new messages are downloaded while the "Incoming" folder is open, those messages will be made 
available immediately, under the heading "Newly Arrived Mail". The same interaction will also 
occur between the mail client and the SMTP daemon. 

• When the mail background check is running, access to the "Open Server" and "Download" 
functions will no longer be disabled. These functions will be made available for all servers except 
the one currently being checked (in the background). 

• A new feature has been added which allows you to specify that new mail should be downloaded 
from a specified server at program startup time. When this feature is enabled, new messages will 
be downloaded and placed in the "Incoming" folder, after which the "Incoming" folder will be 
opened. You can also specify the "Incoming" folder should be opened at startup, without first 
performing a download. 



Notes on Release 4.3a 
  

Terminal 

• If you have more than one instance of QVT/Term running at once, you can switch between them 
directly by pressing the key combination <Alt+N>. 

• Successive default QVT/Term windows will be careful not to open all at the same location. They 
will be cascaded by a small amount, so that it is visually apparent that multiple QVT/Term 
windows are present. 

• You can now select any of the three sizes of DEC Fixed font from the "Font" menu. 

• A new checkbox option, "Always Use DNS", has been added to the "Default Settings" 
configuration dialog. This option, when selected, instructs QVT/Term to initiate each new 
network connection with a fresh DNS query; cached IP addresses will not be used. This feature is 
valuable in situations where name/address mappings change frequently, and IP addresses become 
stale. 

• A bug relating to the initiation of a new session in an already-maximized window has been fixed. 
Prior to this fix, QVT/Term would not correctly report the logical screen size to the host. 

• QVT/Term will no longer store the printer device settings between sessions, but it will still 
maintain them within a session. For example, if you run a report in landscape mode, the next print 
job for that printer – within the current QVT/Term session – will also be printed in landscape 
mode (unless you reconfigure first). 

• A new item, "Timeout", has been added to the "Default Settings | Printer" configuration page. 
This item allows you to set the value, in seconds, that QVT/Term will wait upon receiving a 
"close printer" command. If your print jobs open and close the printer on each line, and if the jobs 
seem to be cutting off prematurely, you can consider extending this value. 

• The user-specified default download directory will now be used as the initial location for captured 
screen images. 

• On some 800x600 displays, QVT/Term would incorrectly calculate the logical screen size when 
the window is maximized. This bug has been fixed. 

• When performing a Kermit download, filenames that contain multiple repeated characters were 
not being handled correctly. This has been fixed. 

• When used in a Windows 9x environment, QVT/Term would sometimes crash on closing. This 
would occur most often if unsaved changes had been made to the current (non-default) 
configuration. This bug has been fixed. 

• The QVT/Term window will now size correctly when the "Large Fonts" option is selected in the 
Windows Display Properties. 

• In previous releases, QVT/Term would not allow you to specify a SOCKS firewall and port 
without specifying a username also. This has been fixed; you can now specify the firewall address 



and port without having to include a username. 

• Previous releases of QVT/Term have allowed the use of a "custom" font that employed a non-
Western character set (or "script"). However, the selected character set was not saved for later re-
use, which required the user to re-select the desired script for each new session. This is corrected 
in release 4.2e. 

• QVT/Term has trouble interacting with DDEML on certain Windows 9x systems. This results in 
a crash when QVT/Term is closed. As a workaround, we have introduced a feature that allows the 
user to disable DDE support in QVT/Term. This is done via a registry entry, accessible using 
REGEDIT. To disable QVT/Term DDE support, add a string value "Enable-DDE" to the registry 
key "HKCU\Software\QPC\QVTNet\4.1\Terminal\Defaults". The data portion of this string value 
should be "NO". 

• The "ScrollLock" key can now be programmed. 

• When opening a session, the current keymap will remain in effect unless a new configuration is 
loaded which specifies a different keymap. This should do away with the situation in which the 
key mappings are "lost" without warning. 

• A "Printer" tab has been added to the "Current Settings" dialog. This allows you to modify printer 
settings for the current session, without affecting the default settings. In the present release, 
however, changes made to printer settings via "Current Settings" are not saved. Future sessions 
will use the default settings. 

• You can now elect to suppress the "Save Changes" prompt which often comes up when closing a 
QVT/Term window. This option can be found in the "Default Settings | Files" dialog box. 

• You can now set a policy on how QVT/Term will behave when the user attempts to close a 
QVT/Term window, while a host session is still active. The purpose is to ensure that the user 
doesn’t inadvertently lose a session, or drop a session without first performing a proper logout. 
There are three policy levels: "No Restrictions", "Confirmation Required", and "Logout 
Required". This option can be found in the "Default Settings | Connectivity" dialog. 

• Support has been added for the DEC LKx50 keyboard. This option is selectable from the "Default 
Settings | Keyboard" dialog. 

• The "NumLock forced on" behavior has been eliminated. QVT/Term will behave identically 
whether NumLock is on or off. The state of the numeric keypad should matter only on laptop 
computers, in which case it should be OFF. The requirement that <Shift+NumLock> be used to 
toggle NumLock remains in effect. 

• The menu bar is now hidden while in kiosk (i.e. captive) mode. This means that kiosk mode 
sessions must always be launched from a desktop short that contains the target host name on the 
command line. Also: when operating in kiosk mode, the "Logout Required" and "Auto Close" 
options are automatically selected, which means that a kiosk-mode session can only be terminated 
by logging out of the host. 

• It is now possible for a system administrator to place a "master" default configuration for 
QVT/Term in the system registry. This configuration will be used if no user-specific 
configuration exists. This feature is useful in situations where administrators want certain settings 
selected on all PCs where QVT/Term is installed, and those settings differ from the factory 



defaults. 

• The "ksend" and "krecv" statements have been added to the QVT/Term script language. These 
statements allow you to send and receive files using the Kermit protocol. 

  

FTP Client 

• An automatic file-typing mechanism has been added. This makes it unnecessary to manually select "text" 
or "binary" before initiating a file transfer. It also allows you to mix text and binary files in a single batch. 
If desired, this feature can be disabled; you can select a specific transfer mode and force the transfer to be 
performed using that mode throughout. 

• A "time remaining" display has been added to the file transfer window. This will show the expected elapsed 
time for each file transfer. 

• QVT/FTP allows you to exclude passwords from the hosts database. If you have chosen this option, you 
have been getting an unwanted "OK to update entry?" prompt each time you log on to a host. This bug has 
been fixed; the prompt will appear only if the username (or hostname) has been changed. 

  

Mail Client 

• A new option, "Color Scheme", has been added to the "Preferences" dialog. You can select either 
white letters on a blue background, or black letters on an off-white background. 

• In the previous release, the display font size would remain at 10 pt no matter which size was 
selected. This bug has been fixed. 

• A "Delete" button has been added to the "Transmit Queued Messages" window. This allows you 
to delete a queued message without sending it. 

• A bug in the parsing of multiple in-line message parts has been fixed. All parts will be included in 
the reply, not just the last part. 

• If a message is deleted from the "Search Results" folder, it will also be deleted from its "home" 
folder. 

• Messages that contain attachments will be marked with a "+" in the message list. 

• An option has been added to the mail downloader that allows you to specify that the "n" most 
recent messages should be downloaded. 

• If a ZIP file is received as an attachment, then unzipped by QVT/Mail’s internal unzipper, the 
resulting files will be added to the on-screen attachment list (in the pull-down combobox). 

• You now have the option to package outgoing attachments into a ZIP archive. 

• An option has been added to the SendMail "Setup" menu that allows you to enable or disable 
"Offline" mode. 

  



Miscellaneous 

• FTP Server: when creating an ACL, it is important that you begin the ACL with the fully-
qualified pathname of the directory that you are protecting. If the pathname contains blank 
spaces, it should be enclosed in double-quotes. 

• Servers: we have tested the QVT/Net servers with the Microsoft SRVANY.EXE utility, and 
confirmed that they can be run as services, using the instructions provided by Microsoft. Make 
sure that you have the server set to "start on launch" (Setup dialog). Also: you will have to choose 
an account under which the services will run; this should not be "administrator"! Be aware that 
the application windows will not be visible; you will not be able to use the "Setup" menu to make 
changes to the application configuration. If you need to make changes, you should first use 
"Control Panel | Services" to stop the service. Then, launch the server as an application and make 
the changes. You can then close the application window and restart the service. 

   



Notes on Release 4.2d 

 

Terminal 

• Terminal: A new menu item has been added that allows you to update the default configuration 
values for screen size and position, font, and color scheme, using current values. 

• Terminal: printer device settings (e.g. portrait/landscape) will be stored across print jobs within a 
session. 

• Terminal: all printer-related menu items have been collected together under the "Printer" pull-
down menu. Some items are duplicated elsewhere. 

• Terminal: support for the NumLock "forced on" mode has been restored when running under 
Windows NT. 

 

FTP Client  

• FTP client: SOCKS support has been reinstated. 

 

FTP Server 

• FTP server: passwords and home directories are now stored in the registry, rather than in the 
"ftppass" file. As a result, user accounts must be rebuilt manually. 

 

Mail Client 

• Mail/News: a new text/HTML control is employed in this release. The new control allows you to 
select text and paste it to the clipboard, using standard techniques. 

  

  



Notes on Release 4.2 

  

• The "Printer Dialog Error 4107" problem has been fixed in QVT/Term. This error, which 
occurred if the QVT/Term default printer was removed from the system, is handled by falling 
back to the Windows default printer if the QVT/Term default printer cannot be found. 

• You can now specify that QVT/Term should always use the Windows default printer, and not 
attempt to keep track of its own default printer. 

• You can now specify that QVT/Term should not prompt before the first print job in a session. If 
this option is selected, printing will begin immediately, using the available default printer. 

• A limitation on the ability to select fonts which employ scripts other than "Western" has been 
removed. 

• QVT/Term script files now use the extension ".QSF", instead of ".SCF", which belongs to the 
Windows operating system. Backward compatibility has been preserved, however; existing 
scripts which use the extension ".SCF" will continue to be recognized. 

• The "printer" toolbar icon now performs a "print screen" function, as opposed to toggling "auto 
print" mode. 

• The "Print Setup" and "Print Screen" functions have been moved to the "File" menu. 

• QVT/Term will now return from a scrolled-back state immediately following any keystroke, not 
just the <Esc> key. In addition, if the key pressed represents ordinary data, it will be transmitted 
to the host, rather than "eaten" by QVT/Term. This revised behavior is in accordance with 
published user-interface standards for Windows applications. 

• The SOCKS setup page has been reinstated to the QVT/Term "Default Settings" dialog. This is to 
be used if you communicate through a SOCKS firewall. 

• You can now email QVT/Term screen images, using the new "Screen Image - Mail" menu item. 
You must provide a recipient email address, subject line, a return address, and the name of an 
SMTP mail gateway. 

• You can now indicate that QVT/Term windows should be resizable or non-resizable. The latter is 
useful in situations where it is important to maintain a certain window size for reasons of host 
application compatibility (some host applications don't run will in non-standard window sizes). 
This option will be found in the "Default Settings" dialog. 

• If a QVT/Term connection takes more than a couple of seconds to complete, a status window will 
pop up, indicating the pending connection. This window also contains a "Cancel" button, that you 
can use to abort the connection attempt. 

• A "Print" icon has been added to the FTP client main screen. You can use it to print files from 
either the local or remote filesystem 

• The Mail and News clients have been combined into a single application 



• An lpr daemon has been added to the QVT/Net suite 

• A POP3 server has been added to the QVT/Net suite 

• A command-line utility for sending email has been added 

• The method used by the FTP server for storing username/password information has been 
changed. As a result of these changes, it will be necessary to reconstruct any existing database 
manually. 

• Some changes have been made to the FTP client for the purpose of increasing throughput. 

• The FTP server will now report the IP address of the remote system as soon as a connection 
request is made. This will allow you to identify possible attacks on your PC. 



Notes on Release 4.1.5c 

  

• The Default Settings setup page now includes a selection labelled 'Resize Action'. This allows 
you to specify how QVT/Term will behave when the application window is resized. There are 
two possibilities: either the display area will change (different number of rows and/or columns), 
or the font will rescale to fit the new window size, while retaining the same number of rows and 
columns. Please note that this logic applies only if a TrueType font (e.g. DEC Scalable) is 
selected. If a fixed-size bitmap font is selected, the display area will always resize, and the 
character size will remain the same. Note also that pressing and holding the <Ctrl> key while 
resizing will select the opposite of the default resize mode. For example, if the default resize 
action is 'Window', pressing and holding the <Ctrl> key while resizing will cause the font to 
resize instead of the display area. 

• The high bit of any outgoing character can be set by pressing <Ctrl+Alt> together with the 
character. 

• When scrolling through the scrollback buffer using the scrollbar 'thumb', the window contents 
will now scroll in sync with the mouse. 

• The list of configurations in the 'Open Session' dialog is now sorted. Also: the default 
configuration does not appear in the list. Instead, the default configuration is selected using a 
dedicated radiobutton. 

• The 'xterm' escape sequence for setting the window title is now supported. This escape sequence 
is formatted as follows: <Esc>]2<window title>\007, where <Esc> represents the ESC character 
(\033), and \007 represents the ASCII character 7 (BEL). 

• Both the name and mode of the default printer are now saved. This means, for example, that 
landscape mode, once selected, will remain in effect until a different mode is selected. You will 
be required to select a printer and a print mode for the first print job of a QVT/Term session, but 
the selected settings will remain in effect for the remainder of the session. 

• There is now more extensive error reporting if errors occur during printing. 

• A bug has been fixed which was causing the 'hosts' file to be written incorrectly. 

• When a new configuration is saved, the list of configurations that is shown in the 'Open Session' 
dialog will be updated. 

• A bug has been fixed that was causing print jobs that use 'overprint' to come out incorrectly. 

• Since the DEC terminal assigns no useful defaults to the first four 'F' keys, QVT/Term now uses 
these keys to 'double' the functions of the four 'PF' keys. This should be useful in situations where 
the physical mapping of the 'PF' keys is awkward or user-hostile. 

• QVT/Term now supports the transmission of 8-bit characters, by pressing <Ctrl+Alt> together 
with the character whose 8-bit version you want to send. For example, to send the 8-bit (i.e., high-
bit set) version of the character 'A', press <Ctrl+Alt+A>. Note, however, that some telnet 
daemons will filter out the high-bit. 



• In some circumstances, the print functions would generate an extra page at the end of the print 
job. This bug has been fixed. 

• QVT/Term will now respond to mouse clicks during a data 'flood'. 

• A bug in the handling of the 'Save Hosts' function has been fixed. 

• The modem dialing method (tone or pulse) is now user-selectable. 

• A bug in the layout of the 800x600 DEC Fixed font has been fixed. This bug caused some 
discrepancies in the cursor position when in 132-column mode. 



Notes on Release 4.1.4 

  

Terminal 

• The ability to specify a 'default printer' has been restored. This capability was dropped in release 
4.1.2, and is restored in the present release. 

• Certain non-printing characters in the high half of the DEC Multinational Character Set are now 
being ignored, as they should. Previous releases allowed them to pass through, which resulted in 
the display of anomalous characters. 

• Handling of the <Ctrl+Break> key combination under Windows NT 4.0 has been fixed. 

• Maximizing the screen while in 80-column mode will leave the logical screen width unchanged, 
even though the physical screen width changes. In 132-column mode, the logical screen will 
adapt to the physical screen (always maintaining a minimum of 132 columns). 

• The 'onscreen' script command has been fixed. 

• In the 'Current Settings' setup dialog, the selection of 'LF' as the newline character will now be 
saved correctly. 

• The syntax for initiating a DDE conversation with a QVT/Term window has been changed. 
Instead of using the configuration name alone as the DDE topic, you must now use the 
configuration name together with the session number, separated by a colon. For example, if the 
QVT/Term window that you want to connect to is using the default configuration, and the session 
number is 1, then the DDE topic will be 'default:1'. The configuration name is the label that 
appears between square brackets in the title bar; the session number is the number that appears in 
parentheses just to the left of the configuration name. 

• The rules which apply to the naming and placement of keymap files and script files have been 
tightened. Beginning with version 4.1.4, all keymap and script files must reside in the 
\QVTNET\BIN directory. All keymap files must have the extension ".km", and all script files 
must have the extension ".scf". When you are prompted to name a keymap file or script file, 
please supply only the 'root' portion of the name. Omit the directory and extension; they will be 
supplied by QVT/Term. 

• Some menuitem shortcut-key assignments have been changed. This was done to prevent 
menuitems from being inadvertently activated. 

• When dragging the mouse leftward to select text, you can now select all the way to the leftmost 
character in the window. 

   

 



Notes on release 4.1.2 

  

Terminal 

• Some problems have been fixed in the handling of 'full-screen' mode as the default mode. 

• Performance and reliability of the printing functions has been improved. 

• A 'captive mode' option has been added. This disables most menu options, and allows the 
presentation of a controlled environment to the user. Please email me (chloe@qpc.com) for 
instructions on how to enable this mode. 



Notes on release 4.1.1 

 

Terminal 

• The default custom font can now be a 'Bold' font. 

• At startup time, the absolute size of the Terminal window will be retained even if it overflows the 
available screen area. 

• A scrolled-back display will now be returned to the 'home' position at the first keystroke. 
However, that keystroke will not be transmitted to the host. 

• The status bar will now redraw correctly after a window resize. 

• All of the QVT/Term-specific DEC fonts are now installed into the Windows environment at 
setup time. This will do away with the need to place the font files in any particular directory, and 
will ensure that the fonts can always be found, even if QVT/Term is launched from within 
another application (e.g. Netscape). 

• QVT/Term will not react improperly to repeated 'close' or 'fail' messages from Winsock. 

• A 'Slow Paste' option has been added to the 'Edit' menu. This is for use in cases where the host 
system cannot accept pasted characters at full speed. 

• The trailing '/', if present, will be dropped from telnet URL's before final interpretation. 

• The 'View' menu has been expanded. Items have been added to allow quick access to the screen 
width (80/132) and display mode (window/screen). 

• The VGA-res 132-column font has been widened from 4 pixels per character to 5. This will 
significantly improve the readability of the 132-column display. As a result of the added character 
width, only about 128 columns will actually be visible; horizontal scrolling will be needed to 
view the rightmost columns. 

• The 'paste' function now works correctly within the context of a 'local-echo' telnet session. 

• Support for the MS LineDraw font (LineDraw.ttf) has been added. If you have this font on your 
system, you can select it for use as a 'custom' font, and QVT/Term will employ the line-drawing 
characters where needed. 

• A problem with printing to HP LaserJet 4 printers has been fixed. The problem occurred when 
performing a series of screen-prints; the second and all subsequent screen-prints would appear as 
a solid black rectangle. 

• When performing host-directed printing, the printer device context is set to 'transparent', which 
allows the use of overstrike techniques to produce underlining on line printers and matrix 
printers. 

• Previous versions of QVT/Term 4.x had trouble calculating the window size in a Windows 95 
'Large Fonts' environment. These problems have been eliminated in release 4.1.1. 



• The 'answerback' feature now works correctly. 

• Resizing the window in a 'full-drag' environment will no longer trigger a rapid series of repaints. 
Instead, a single repaint will be performed with the resize is finished. 

 



Notes on Release 4.1 
  

• All applications  now use the Windows Registry as a repository for setup information. This 
means that you will have to re-do the initial setup on all of the applications. Also, a couple of 
setup values are now shared among several applications, most notably those having to do with 
sending email (SMTP host, email address). These values can be modified only by the 'Mail' 
application. Therefore, we recommend that you start QVT/Mail first, in order to take care of these 
important setup tasks. 

• We have added a new 'DEC Scalable' font, and dropped the 'DEC Small' font. The DEC Scalable 
font is available in sizes ranging from 8pt to 16pt. You can have 24x80 windows of almost any 
reasonable size, using the built-in point sizes. In addition, you can create new sizes 'on the fly' by 
pressing and holding the <Ctrl> key while you resize the window. This method can be used not 
only with the new DEC Scalable font, but with any TrueType font. Note, however, that these non-
standard character sizes cannot be saved for later use (at least not in the present release). 

• The menu bar has been reorganized for easier access to the various sections of the 'Setup' menu. 
There are now separate submenus for Keymaps, Printer, and Font setup. 

• You can now specify a default download directory as part of the 'Default Settings'. This will be 
the initial target of Kermit downloads. 

• By default, if you try to close a Terminal that contains a 'live' session, you will be prompted for 
confirmation before the window is closed. This confirmation prompt can now be defeated, by 
deselecting the checkbox labelled 'Confirm Disconnect on Close', which appears on the 
'Connectivity' setup page (Default Settings only). 

• Some bugs in the printing function have been fixed. 

• A new statement - "password" - has been added to the script language. This is for use in situations 
where it is undesirable to store passwords in script files. 

• A new statement - 'onscreen' - has been added to the script language. This statement allows you to 
search for a string on the screen. 

• A new dedicated color is provided for use with the 'reverse video' attribute. This color will be 
used instead of the default 'foreground' color as the background for reverse-video characters. 
Characters that are displayed as high-intensity reverse video will still use the dedicated 'bold' 
color as the background. 

• The Terminal and FTP client applications will now accept URL's as command-line arguments. At 
a minimum, the host name given in the URL will be accepted as the host for the new session. Any 
additional information, such as username and password, will be used as well. Note that only fully-
formed URL's will be accepted; i.e., the protocol must be present in the URL as the first portion 
of the string. Note also that, in the Terminal application, a valid default login prompt and 
password prompt must be provided; see the 'Default Settings' setup dialog. 

  



Notes on Release 4.0.5 
  

• A 'View' menu has been added, which allows you to selectively hide or show various window 
elements, such as the toolbar and status bar. 

• Support for the 'blink' attribute has been added. 

• A 'severity' statement has been added to the script language. By issuing the statement 'severity 
continue' at the beginning of a script, you allow the script to continue even if a timeout occurs on 
a 'wait' statement (the default behavior is for the script to abort). This in turn allows the use of a 
'goto' statement to modify the flow of a script depending on whether a 'wait' succeeds or fails. The 
two flavors of 'goto' are 'if_err_goto' and 'if_noerr_goto', which can be used as appropriate to the 
situation. The target of a 'goto' must be a label, which is a line consisting of the label text 
preceded by a colon (':'). This format is the same as that used in MS-DOS batch files. 

• A 'homedir' directive has been added to the [defaults] section of TERM.INI. The value of this 
(optional) directive will be the name of the directory where TERM.CFG and other files of this 
type are stored. By placing TERM.INI in the \WINDOWS directory, and including a 'homedir=' 
statement, you can assure that QVT/Term will be able to find its configuration files even when 
launched from within a Web browser (rather than from a Win 95 'shortcut'). 

• The window-resizing functionality has been enhanced, to take account of situations where you 
want to change the font size, not the number of displayed rows and columns. To apply this 
feature, press and hold the <Ctrl> key while you are resizing the window. When you terminate 
the resize operation, the font size will be changed to fit the new window size. Note: this feature is 
available only when using TrueType fonts. You can select a TrueType font via the toolbar font 
selector. QPC will be providing a TrueType DEC terminal font in the near future. 

• Some bugs in the display of ANSI color text have been fixed. Colored text should now be easier 
to read, and some problems with screen corruption have been fixed. 

• Some problems with transparent printing have been fixed. 

• The 'Save Hosts' command has been added to the 'File' menu. This allows you to update your 
'hosts' file with names that are obtained during terminal sessions. 

 


